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QUEST FOR GLORY I TECHNICAL MANUAL 

How to Read this Manual 

Throughout this manual we will use the following ways of representing 
information: 

MENU COMMANDS will be capitalized. 
Example: SA VE, RESTORE, QUIT, PAUSE GAME 

Typed commands will appear as bold type. 
Example: ' type: ask about brigands ' 
' type: cd \sierra' 

Portions of the command line not meant to be typed will not appear in bold 
type. For example, in the line ' type: cd \sierra ', 'type: ' should not be typed. 

[EXAMPLE TEXT] and [Keystrokes) will appear in brackets setting them off 
from the surrounding text. 

Example: [NAME OF GAME] [NAME OF DIRECTORY] 
[Spacebar] , [Tab], [PageUp] 

The brackets are not keystrokes and should not be typed. 

Two or more keys that should be pressed at the same time will be separated by 
a hyphen (-). This hyphen is not a keystroke, and should not be typed. 

Example: ' Press [CTRL-1) to view your inventory. ' 
If a space appears between parts of a command, it is meant to be typed. 

Example: ' type cd \sierra ' (the space between cd and \sierra 
should be typed as part of the command) 

The term 'diskette ' is used to refer to either 3.5" or 5.25" data storage disks. 
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ALL SYSTEMS 

PLEASE NOTE: If there is a README file on your game diskette, it may 
contain important information and instructions that were not available at 
the time the documentation and other materials for this game were 
printed. 

GETTING STARTED: DISKETTE DRIVES 

It is always advisable to make back-up copies of your master program diskettes 
to increase the life of the masters and guard against accidents. Follow your 
computer's instructions to make copies of all game diskettes. 

If you will be playing from diskettes rather than a hard disk, you will also want 
to format a blank diskette for saving games. In fact, saving games to diskettes 
is a good idea, even if you are playing the game from your hard disk. Follow 
your computer 's instructions to format a blank diskette and keep it handy for 
saving your game as you play. For some helpful tips on saving games, see the 
'Saving Your Game' (Page 10) and 'Interacting with Quest for Glory I' 
(Page 12) sections of this manual. 

When installing your program, you may be prompted to insert a 'Drivers ' disk. 
If you receive this prompt, please examine your disks and insert the disk marked 
'Drivers' and press [ENTER], so that the appropriate drivers will be loaded. 
Some games do not include a separate 'Drivers' disk. 

MS-DOS 

INST ALL THE GAME 

Place the back-up copy you have made of disk 1 into your diskette drive. Type 
the letter of the disk drive you have placed the disk into followed by a colon 
(for example: a:), and press [ENTER]. Type: install and press [ENTER] . 

Answer the onscreen questions using the up and down [Arrow) keys to highJi~ht 
your selections, then press [ENTER] to select. You will be asked if you wish 
to install the game on your hard disk. If you do not wish the game to be installed 
on your hard disk, press [ESC] to skip this step. If you want to install the game 
on your hard disk, enter the letter designation of your hard disk (usually C) and 
follow the prompts. 

Please note: Evem if you install to a hard disk, the install procedure will 
write a file named RESOURCE.CFG to disk 1. For the installation to be 
completed correctly, DISK 1 MUST NOT BE WRITE PROTECTED. No 
other files on disk 1 are written or changed by the install command. 
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LOADING INSTRUCTIONS 

After completing the INST ALL procedure: 

From diskettes: 

1. Place disk #1 into the A: drive. 
2. Type: a: and press [ENTER]. 
3. Type: sierra and press [ENTER] . 

From hard disk: 

1. From your root directory, type cd \sierra and press [ENTER] . 
2. Type hero and press [ENTER]. 

SAVING GAMES TO DISKETTES 

Choose SA VE GAME or press the [F5] key. The Save Game menu will appear. 

Choose CHANGE DIRECTORY. Backspace or press [Ctrl-C] to clear the 
command line. 

Type the letter of the drive you are using for saved games, followed by a colon 
(Example: a:) and press [ENTER] . 

Type the name of your saved game and press [ENTER] to complete the SA VE 
GAME procedure. If your disk for saving games is full , you may reformat it 
(this will erase the saved games on the disk) and use it over, or use another 
f01matted blank disk. 

SAVING GAMES TO HARD DISK 
If you choose to save games to the hard disk, the program will auotmatically 
try to save to the games 's own directory , and name the games [NAME OF 
GAME DIRECTORY]\GLORYSG.001 , etc., through \GLORYSG.012. If 
you run out of space for saving games, try one of the following alternatives: 

Save additional games to a diskette. 

Save games to a different directory by choosing CHANGE DIRECTORY from 
the SA VE GAME menu (inside the game). 

Delete the saved games and the saved game directory from your hard disk by 
following DOS instructions (outside the game). The program will create a new 
index file within the game directory. 

Create a new hard disk directory from DOS, using DOS instructions. 
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ATARI ST 

LOADING INSTRUCTIONS 

Note: If you are u_sing an Atari 520 ST without memory expansion, turn off 
a~l desk accessones (rename .ACC extension .ACX) before running your 
Sierra game. 

1. .If you are playing the game from diskettes: Place disk 1 in 
dnve A, open the disk by double-clicking on its icon. Start the 
game by double clicking on SIERRA.PRO. 
2. If you are playing the game from a hard disk : Open the disk 
by doubl~-cl.1cking on its icon, then open the game folder by 
double-clicking on the game folder icon. Start the game by 
double-clicking on SIERRA.PRO. 

HARD DISK INSTALLATION 

Please note: More than 5 I 2K of memory is needed in order to run Sierra games 
on your ST If you have a hard disk. 

1. If you are playing from a hard disk, first make sure you have 
enough space on the hard disk for the game - single-click on 
the disk icon, then select SHOW INFO ... from the File menu. 
Bytes Available should be at least 800,000 times the number of 
diskettes included with the game (400,000 times the number of 
single-sided diskettes). 
2. Open the hard disk by double-clicking on its icon. 
3. Create a game folder by choosing NEW FOLDER ... from the 
File menu. Open the new folder by double-clicking on its icon. 
4. Place disk #1 in drive A. 

5 . . Copy ~he g~e disk i~to the new game folder by dragging the 
dnve A icon into the window you opened in Step 3. (Click on 
the drive icon, then while holding the mouse button down, move 
the mouse arrow over the open window, then release the button.) 
6. Repeat steps 4 and 5 for each of the other game disks. 
7. Put the master disks away in a safe place. 

CHOOSE A MUSIC DEVICE (Optional) 

Yo~r.Sierra game is initially set up to play music and sounds through the Atari 
ST s internal speaker. If you have one of the supported MIDI synthesizers, you 
may ru~ the MUSIC program to have the game play music through the 
synthesizer. 

1. Open the game disk/folder by double-clicking on its icon. 
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2. Run the MUSIC program by double-clicking on the 
MUSIC.PRG icon. 
3. Select MUSIC DEVICE from the Options menu. 
4. Select your synthesizer (or 'Atari ST Internal Sound') by 
clicking on the appropriate button. Then click on OK. 
5. Select INST ALL GAME from the File menu. This will replace 
the RESOURCE.CFG file on your disk. 

Please note: It is important to turn your synthesizer on before playing the game. 

A MIGA 

INST ALLING THE GAME 

NOTE: RENAME your copies of all game disks to remove the 
words'COPY OF' from the disk name. If the words 'COPY OF' are not 
removed from the disk names of ALL the copies, the system will continue 
to ask for the original disk, and will not run the game. 

1. Boot your system with WorkBench, and insert Disk#! of your 
Sierra game. 
2. Double-click on the disk icon, then double-click on the IN­
ST ALL icon. 
3. Follow the onscreen prompts, choosing your election with 

the mouse by clicking once on the item. 
4. You will be asked if you wi h to install the game on your hard 
disk. If you do NOT wish the game to be installed on your hard 
disk, select NO. If you want to install the game on your hard disk, 
select YES. 
5. Using your mouse, select which hard drive you wish to install 
the game onto. 
6. Follow the onscreen prompts to complete the installation. 

LOADING INSTRUCTIONS 

From Floppy Diskettes: 
1. If you have less than 1 megabyte of memory for your Amiga, 
disconnect any external drives while your system is off. 
2. Insert Disk #I into drive DFO:. 
3. Turn on your system. 

From Hard Disk: 
1. Load WorkBench and double-click on your hard disk icon. 
2. Double-click on the SIERRA GAMES drawer. 
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3. Click on the drawer for the desired Sierra game. 
4. Click on the game icon. 

ALL SYSTEMS 

MOVING YOUR HERO 

You may move your characteron the screen with the [Arrow] keys, the numeric 
keypad, or the mouse. To halt your character's steps with the keypad, press the 
number 5, or press the last used direction key again. Do not attempt to move 
the character by holding down the direction key. This will cause the 
character to start and stop continuously, resulting in very slow progress. 

Using ~e mouse, position the arrow to where you want the character to move, 
then chck the left mouse button. Nw N Ne 
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MENUS SW s 

When you press [ESC], a menu bar will appear at the top of your screen with 
several menus that can be opened to show the command choices available to 
you. 

KEYS TO USE IN THE MENUS 

Use the left and right [Arrow] keys to open a menu, and the up and down 
[Arrow] keys to highlight items within a menu. 

Press [ENTER] to select a highlighted command. 

Press [ESC] to return to the game without choosing a command. 

GAME SPEED CONTROL 
At times it may be useful to slow down the speed of the game animation in 
order to negotiate a tricky section, or observe something more carefully. At 
other times, you may wish to speed up the game actions. In Quest for Glory 
/ , animation speed is controlled by the [ +] and [-] keys, or by selecting a 
choice from the Speed menu, using the mouse or [Arrow] keys. You may 
also choose HIGH SPEED HERO or NORMAL HERO SPEED from the 
Game menu. On slower computers, use the HIGH SPEED HERO command 
to walk more quickly. You may find it necessary to return to NORMAL 
HERO SPEED for maneuvering in tight areas and entering new room . 
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SHORT CUTS FOR COMMON COMMANDS 
You can use function and control keys to short cut many common commands. 

[Fl] Help 

[F2] Toggle sound on/off 

[F3] 

[F4] 

[FS] 

[F7] 

[F9] 

[TAB] 

[CTRL-A] 

[CTRL-C] 

[CTRL-E] 

[CTRL-F] 

[CTRL-H] 

[CTRL-1] 

[CTRL-L] 

[CTRL-P] 

[CTRL-Q] 

[CTRL-S] 

[CTRL-T] 

[+] 

[-] 

[=] 

Repeat previous command 

Toggle High Speed/Nonnal Speed Hero 

Save Game 

Restore (saved) Game 

Restart Game (from beginning) 

Inventory 

'Ask About' 

'Cast' Spell 

'Escape' (Retreat from Combat) 

'Fight' 

About Quest for Glory 

Inventory 

'Look At' 

Pause Game 

Quit Game 

Show Character Sheet (Status, etc.) 

Time of Day 

Increase Animation Speed 

Decrease Animation Speed 

Normal Animation Speed 
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[CTRL-V] 

[SHIFT-CLICK] 

[SPACEBAR] 

SHIFT CLICK 

Change Volume 

'Look' at an object (see below) 

Repeat Last Command 

SHIFT-CLICK is a feature that will allow you to ' look' at a person or object 
using your mouse. Place the mouse arrow on the desired person or object, then 
hold down the [SHIFT] key and press the mouse button. You will now receive 
a descriptive message. 

* Please note: Multi-button mouse users should use the RIGHT mouse 
button, and need not press [SHIFT]. 

USING YOUR TAB KEY 

While playing Sierra games, your [TAB] key will perfonn two major functions. 
You will use it to review the items in your inventory, and also (if you're not 
using a mouse) to select options from certain menus. The following menus will 
require the use of the [TAB] key for highlighting menu options: 

MENU CHOOSE FROM 

1. Opening Screen Introduction, Start New Hero, Continue Quest 

2. Restart Game Restart, Continue 

3. Quit Game Quit, Don't Quit 

4. Character Sheet Character etup choice 

5. Save Game Save, Change Directory.Cancel, Replace 

6. Restore Game Restore, Change Directory, Cancel 

7. Dead Hero Restore, Restart, Quit 

USING THE MOUSE (optional) 

Your mouse will be useful to you in moving your character, and in learning 
about your surroundings. To move your character using the mouse, position the 
arrow to where you want the character to move, then click the left mouse button. 
In many scenes, you can find out about a person or object by using the 
[SHIFT-CLICK] feature described in the 'Short Cuts For Common 
Commands' section of this manual. 
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EXAMPLES OF COMMON COMMANDS 
Communicating with Quest for Glory I 
Many characters in the game will have information of one kind or another for 
you. To talk with a character, type: ask about [character, subject or object] (for 
example: ask about the brigands) or press [CTRL-A], then type [character, 
subject or object]. Using a mouse, choose the menu command ask about. Try 
different approaches, and talk to everyone you meet. 

You may encounter objects you need along the way. To take an object, type: 
take [object]. For example, take the note. You will need to use the objects you 
acquire as you explore. You can try different things such as typing: use the 
[object], or give the [object] to [character] . Different approaches to a puzzle 
may bring about a different outcome. 

Pay close attention to details. To examine objects, type look at the [object], 
(for example: look at the table), or press [CTRL-L] , then type the name of the 
object. 

Using a mouse you can also use the 'Shift-Click' feature described in the 
'Short-Cuts For Common Commands ' section of this manual. To get a general 
description of the current room or scene, type look, or use your mouse to choose 
LOOK from the menu. 

RETYPING COMMANDS 

If you wish to repeat a command select RETYPE from the ACTION menu or 
press the [SPACEBAR] or [F3]. 

INVENTORY 

If you wish to see the items you are carrying, select INVENTORY from the 
Action menu, P.ress [CTRL-1), or press the [TAB] key. A list of the items you 
are carrying will be displayed. Press [ENTER] or [ESC] to resume play. 

PAUSING YOUR GAME 

If you wish to pause the game, select PAUSE from the Action menu, or press 
[Ctrl-P]. Press [ESC] or [ENTER] to resume play. 

SAVING YOUR GAME 

If you wish to save your game, select SA VE from the File menu, or press [F5]. 
To allow for errors in judgement and creative exploration, we recommend that 
you frequently save your game in progress, and that you save several different 
games from different points as you play. You will always want to save your 
game before encountering potentially dan$erous situations. You should also 
save your game after you have made significant progress. 
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Please note: If you 're playing from diskettes, you must have a separate 
formatted diskette ready before you can save a game. We also recommend 
that you create several directories or folders on your save game disk in 
order to assure adequate space for save game storage. 

If you choose to save games to your hard disk, we suggest that you create one 
or more save game directories or folders on your hard disk. See your computer's 
instructions for creating directories or folders. 

You may name your saved games using standard English phrases. For example, 
if you are standing on a sandy beach, you might call your game 'standing on 
sandy beach ', or simply ' beach '. 

RESTORING YOUR GAME 

Select RESTORE from the File menu, or press [F7]. You will be prompted to 
select the game you wish to restore. (On a single drive system, you will be 
prompted to insert your save game disk) . Highlight the desired game and select 
RESTORE. If the game you wish to restore is in a different directory, select 
CHANGE DIRECTORY. 

Please note: If you do not have a mouse, use the [TAB] key to toggle between 
RESTORE and CHANGE DIRECTORY. 

QUITTING YOUR GAME 

To stop playing, select QUIT from the File menu, or press [CTRL-Q]. 

RESTARTING YOUR GAME 

If you wish to restart your game at any time during play, select REST ART from 
the file menu, or press the [F9] key. The game will begin again in front of the 
' Hero Wanted ' sign. 
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INTERACTING WITH QUEST FOR GLORY I 

You can generally interact with the game by typing simple commands consist­
ing of as little as a noun and a verb. For instance, the command sit in the chair 
can be shortened to sit in chair, or even sit. Unless otherwise directed, follow 
all typed commands with [ENTER]. 

A message window will appear after you enter each command, and at other 
times during the game. When you have read the message, press [ENTER] to 
remove the window and resume play. 

Quest for Glory I understands many common verbs. Here are some you might try: 

ASK DROP SEARCH TELL 
BUY EAT PLAY SIT 
THROW CLIMB GET PUSH 
SNEAK USE CLOSE GIVE 
READ STAND WALK DRINK 
OPEN RUN TAKE 

LOOK everywhere. Thoroughly explore your urroundings. Open doors and 
drawers, look under things and behind things for valuable objects and clues. 
Look closely at all objects you encounter or you may miss important detail . 

EXPLORE each area of the game very carefully. Search every area of the town 
of Spielburg, and the valley surrounding it. Be careful!! There are many hazards 
awaiting you! 

DRAW A MAP as you progress through the game. Make a note of each area 
you visit, and include information about objects found there and dangerous 
areas nearby. If you miss an area, you may miss an important clue! 

ASK ABOUT anything you think a character might know, as this is by far the 
best way to learn what is really going on in the valley. But use discretion! Some 
characters will be friendly and helpful. They may give you valuable information 
and advice. Others may mislead you. 

GET objects you think you will need. You will come across a number of objects 
that may be of use to you later, but don't overload your character. The amount 
that you can carry will vary depending on your strength. You can see an 
inventory of items on hand by pressing the TAB key at any time. 

USE the items you have picked up to solve problems in the game, or to help 
you to make progress and discover more clue . 

BE CAREFUL, and remain alert at all time - di aster may strike in the most 
unlikely of places. 12 

SAVE YOUR GAME OFTEN, e pecially when you are about to try some­
thing new or potentially dangerous. Thi way, if the worst should happen, you 
won't have to start all over again from the beginning. Save games at different 
points of the game, so you will be able to return to a desired point in the game. 
In effect, this will enable you to travel backward through time and do things 
differently if you wish. NOTE: You cannot save your game during combat. 

DON'T GET DISCOURAGED. If you come to an obstacle that seems 
insurmountable, don't despair. Spend some time exploring another area, and 
come back later. Every problem in the game has at least one solution, and some 
have more than one. Sometimes solving a problem one way will make it harder 
to solve the next, and sometimes it will make it easier. If you ~et stuck, you 
might try backtracking to an earlier point in the game, then choosmg a different 
path. If all else fails, you can buy the Quest for Glory I hint book from the 
dealer who sold you the game, or you can order it directly from Sierra 
On-Line by calling (800) 326-6654. 
BRING ALONG SOME HELP. You may find it helpful (and fun) to play 
the game with a friend. Two (or more) heads are better than one at interpreting 
clues and solving problems, and Heroes throughout history have worked in 
teams. 
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WHAT IS QUEST FOR GLORY? 
Quest for Glory combines the character development and combat that are 
typical of fantasy role-playing games with the basic adventure game concept 
of exploring a world and solving its puzzles. "So You Want To Be A 
Hero ... " is the first Quest for Glory scenario. 

The essence of role-playing is that you must try to think as your character would 
when faced with a dilemma. In Quest for Glory /, you can choose from three 
basic character types-the strong fighter, the mysterious magician, or the wily 
thief. Each has the same goal; to be named Hero of Spielburg. Each character 
will however, set about accomplishing that goal in a different way. The 
magician may use spells to overcome some obstacles, but might not survive a 
pitched battle with a monster. The thief must fmd a crafty way around the same 
problem that the fighter or magic user would approach directly. 

Experience can be a tremendous asset to you as a hero. Your attributes will 
improve as you play the game. Tasks that are beyond your ability early on may 
become less difficult as your skills improve. 
Conservation is one very important element of Quest for Glory. You will 
meet many strange people and creatures in the valley. To learn about the 
valley and your quest, it will be necessary to speak with everyone you meet. 
Like your character, the beings you meet will have distinct personalities, and 
their skill and knowledge may lie in different areas. You'll want to ask 
specific questions, and find out all you can. 

Every hero must deal with his share of foul and ferocious monsters. If you want 
to be a hero, you '11 have to fight or avoid them, as they don't tend to favor 
discussion. Each battle you fight will provide you with valuable experience, 
and many victories will yield treasure that you will need to buy food and 
equipment. 

A hero's life isn't always serious, though. Between desperate encounters with 
terrible monsters and life-and death decisions lie many light-hearted, humorous 
and downright silly moments. Spiel burg is a strange place with a multi-faceted 
personality, as you will soon see. 
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Creating a Character 
Before beginning your adventure, you '11 choose frof!l three basic c~aract~r 
types - The Fighter; The Magic User; or The. Thief. Your select10n will 
determine much about the sorts of obstacles you will encounter, and the means 
by which you will overcome them. Using your mouse or [Arrow] keys, place 
the cursor on the character type you wish to play, then press [ENTER]. 

Each type of character comes with its own set of skills and abilities, some 
specific to the character type, some. corn~~~ to all tru:e:e. Every t.ype h~s 
pre-assigned point values for arpropn.ate ab1ht1es. In ~dd1tt?n, you w~ll begm 
the game with a 50 point 'pool to assign to the areas m which you wish your 
character to be strongest. 

After you have chosen a character, you may use the [Backspace] key or press 
[CTRL-C] to erase the character's name. Replace it by typing in any name you 
like. 
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The Fighter 

The Fighter depends upon his skill with weapons, his strength, and his vitality 
to survive the rigors of life as a hero. His weapon is his sword , and his best 
defense is his shield. We recommend that you play a Fighter during your first 
Quest for Glory I adventure. 

The Magic User 

The Magic User must rely upon his intelligence and the successful casting of 
magic spells. He can best protect himself by avoiding close combat. 

The Thief 

The Thief counts on his skills, stealth, and agility. His weapon of choice is the 
dagger, and he prefers to throw it from a distance. He can best defend himself 
in combat by dodging. 
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Assigning Skill Points 
To highlight a skill , use the mouse cursor, the up and down [Arrow] keys, or 
press the [TAB] and [SIBFf-T AB] keys. To assign points to a skill , press the 
right [Arrow] key. Each time the right [Arrow] key is pressed, 5 points will be 
assigned to the highlighted skill. Press the left [Arrow] key to subtract 5 points 
from a skill. (You may not delete sbll points below the original value of the 
given sbll.) For ' fine tuning ' use the[+] and [-] keys to add or subtract one 
point at a time. 

To attain a sbll not normaJly available to your character type (such as lock­
picking for a fighter) , choose the desired skill from the sbll menu and assign 
points using the procedure described above. The minimum skill level of 5 will 
require 15 points from the ' Points Available' pool. These will be assigned 
automatically. 

Points for Health, Stamina or Magic cannot be changed by you directly. The 
values for these attributes will change automatically as you gain experience, 
suffer damage and modify certain sblls. 

Abilities: 

Strength is important in performin~ physical activities, especially combat. The 
Fighter must be strong to be effective. 

Intelligence will enable the Magic User to successfully learn and cast spells, 
and will benefit all characters when engaged in mental activities, such as 
out-thinking opponents in combat. 

Agility is important during combat, and vital to lock-picking and stealth. The 
Thief cannot prosper without high agility. 

Vitality determines how much damage a character can sustain, and how quickly 
he will recover from damage and strenuous physical activity. High vitality is 
particularly useful to the Fighter. 

Luck can aid you in many subtle and mysterious ways, and is especially 
important to the Thief. 

Skills: 

Weapon skill determines the character's ability to land a successful blow in 
combat. 

Parry is the ability to block an opponent's blow using a weapon or shield. 

Dodge is a skill used to avoid a blow by ducking or sidestepping it. 
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Stealth is the art of moving quietly and discreetly , taking advantage of shadows 
and other camouflage when sneaking around. 

Pick Locks is the skill that allows a character to triumph over locked doors, 
chests, etc. A lock-pick or thief's tool kit is necessary to use this skill. 

Throw determines your character's aptitude for throwing and accurately hitting 
a target with a small object such as a rock or a dagger. 

Cimb is the skill that allows a character to scale difficult surfaces. 

Magic is the basic skill required to learn and cast magical spells. 

Each character also possesses attributes that are set automatically based on 
certain skills and abilities: 

Health Points gauge the amount of damage a character can suffer before he 
will die. 

Stamina Points determine how much energy a character has to perform 
physical activities. When Stamina points are low, the character is weak. He will 
fight less effectively, and may be injured more easily. 

Magic Points measure the amount of magic a character can perform. When 
magic points are gone, the character will be unable to cast spells. 

Skills and abilities improve with practice. Those skills your character exercises 
frequently will improve more rapidly, while those left unused will remain fixed 
at their original levels. Your character can only advance in skills he is given 
when you create him. 
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Playing A Role 
You will begin Quest for Glory as a recent graduate of the Famous 
Adventurers ' Correspondence School for heroes. A poster in your local 
Adventurer' s Guild reads, "WANTED: HERO. NO EXPERIENCE 
NECESSARY. VISIT BEAUTIFUL SPIELBURG, FIGHT MONSTERS, 
DEFEAT BRIGANDS. REWARD AND TITLE ' HERO OF SPIELBURG' 
TO THE SUCCESSFUL APPLICANT." 

It sounded good, especially the "no experience necessary" part. Now, after a 
month ' s journey over tortuous terrain, narrowly evading death at every tum, 
you aren't as enthusiastic. But, here you are at the town gates , and it's too late 
to tum back. You will defeat the monsters and brigands that plague Spielburg, 
or die trying (the latter seems more likely at this point!). 

Now you must become your character, and learn to think as he would, reason 
as he would, and solve problems as he would. You can only be successful if 
you use your character's own distinct personality to keep him alive. 

Living in this Crazy World 
Just as in real life, there are basic things a person must do to stay alive. You 
will need to eat a couple of meals each day. If you are carrying food, you ' II eat 
automatically, but try not to run out of rations. 

You 'II also need a certain amount of sleep to rei,?;ain Health, Stamina and Magic 
points. Without sleep you will use these pomts quickly. Sleep is best ac­
complished at night, as travel is much safer during daylight hours. Besides, 
heroes are notorious for their 'Type A' personalities. You must be careful where 
you bed down though, or you may wake up as someone's midnight snack. 

Also like real life, basic necessities often cost money. To earn money, you can 
carry out a quest (they ' ll be posted at the guild hall), defeat a wealthy monster, 
or (worst of all) get a job at the castle. In the coin of the realm, ten silver pieces 
equal one gold. Supplies such as food , equipment, magical spells and healing 
potions can be purchased from the local shops. 

You will carry most of your equipment in a backpack. The amount you can 
carry is determined by your strength and the weight of the equipment. 

If for some reason you are in a hurry (a monster on your tail, or some such 
thing) , type run to move more quickly. Don't run too far though, or you 'II soon 
become tired. Type walk to resume walking normally. 
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Winning the Game 
When you complete Quest f or Glory I successfully , you will be given the 
opportunity to save your character for use in Quest for Glory II: "Trial by 
Fire". You will be asked to insert a formatted , writeable disk. Save this 
disk, as it will allow you to begin"Trial by Fire" at an advantage. 

Talking to Other Characters 
You will meet many strange beings in Spielburg Valley - some human, some 
otherwise. Most of them know things that you don ' t, and will need to learn. By 
speaking with them you can gain some of that knowledge. 

Everyone you meet will understand sentences in which you ' ask about ' some­
thing in their areas of expertise. You might ' ask about magic' when speaking 
with Zara in her magic shop, or ' ask about heroes ' when you meet the sheriff. 
You 'II want to jot down anything that seems important, as your conversations 
will provide you with most of the clues you ' II need to become a Hero. 

Many of the replies to your queries will suggest additional questions to ask, or 
lead you to others who can provide you with useful information. For example, 
when you ask the sheriff about heroes, he will tell you to talk to Wolfgang at 
the guild hall, or inquire at Spielburg Castle. Next, he might mention brigands, 
prompting you to probe in that direction. 
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Combat 
The world is full of monsters and villains, and if you want to stay alive long 
enough to become a Hero, you really ought to learn how to fight them. A clash 
will occur any time a monster comes near enough to strike your character, or 
when you type fight. Combat can take place in the room where you encounter 
a monster (allowing more movement and strategy), or the screen may change 
to a close-up view of the monster. 

When you encounter a monster, you will need to react quickly. You can throw 
daggers or cast an appropriate spell while the monster is still at a distance, or 
you can type fight to engage in battle. While in combat, you can cast some 
spells, but you won ' t have time to use healing or other potions. 

DIST A:'liCE COMBAT 

THRUST OR SWING 

~ 
DODGE ~ ~ DUCK 

v 
PARRY 

CLOSE COl\IRA T 

THRUST 

~ 
1>01><;1·: ~ ~DODGE 

v 
SHIELD BLOCK 

Timing is the most important element of combat strategy in Quest for Glory. 
Try to strike when your opponent is ' open', and anticipate his attacks to 
better defend yourself. Your choice to either block or dodge blows should 
depend on your skills and equipment. 

If you feel that the situation has gotten out of hand, you can type escape, or 
press [CTRL-E] to retreat. 

Many battles can be avoided, and it might be wise at times to do so. Combat, 
however, is one of the best ways for an aspiring Hero to practice and improve 
skills. Each time you defeat a monster, you ' II gain valuable experience that will 
increase your chances in future battles. Remember, always search the body of 
your opponent after winning a battle, for some creatures carry money or other 
useful items. 

In most cases, Status Bars are displayed during combat, keeping you informed 
of Health, Stamina and Mana (magic energy) points for your character. As you 
become injured, Health points diminish. You will use Stamina points as you 
work hard at fighting or using your skills. When Stamina points are depleted, 
energy is drawn from Health. When Health points are gone, the character is 
dead. A Health bar is also displayed for your opponent, to show how badly it 
is injured. 
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Thief Skills 
Thief characters have two special skills; 'Pick Locks' and 'Stealth'. To use 
these skills type pick lock to gain entrance to a locked door, or sneak to move 
quietly. When you are finished 'sneaking', type walk to resume walking 
normally. 

Magic 
A Magic User begins the game with one spell: ZAP. He can read and learn more 
spells as he finds or buys scrolls. The spells he possesses will be listed in his 
inventory. Also listed will be the number of Ma$ic Points (MPs) needed to cast 
a spell, and the level of skill the character has m each spell. His spell casting 
will improve with practice. To use a spell, type cast (or press [Ctrl-C]), then 
type [NAME OF SPELL]. 

Playing the Wizard's Game 

First, read 'How to Play the Mage's Maze' in your HOW TO BE A HERO 
guidebook. Erasmus' game has a few variations. 

The maze screen consists of two Status Bars, four Spell Buttons, and a maze 
strewn with bridges, ladders, and boulders. Two hyperactive 'bugs' are trying 
not to fall off the cliffs. The white creature is yours, and the purple one belongs 
to Erasmus. The object is to encourage your bug to finish the game first. 

The Status Bars show your current Magic Points (MP) and the amount of time 
remaining on your current spell. 

You play the game by casting spells at the game board. If you have a mouse, 
simply click the mouse while pointing at a Spell Button. From the keyboard, 
use the left and right cursor keys to move the sword cursor to the Spell Button 
you want, then press [ENTER] to cast the spell. With a joystick, move the stick 
in the desired direction and press the fire button to cast the spell. 

Once you have selected a spell, the Timer starts. How much time you have 
depends on your skill level in the chosen spell. The exception is Trigger, which 
always works, and takes effect immediately. 

Use Fetch to move a bridge or ladder into position. Point the mouse at any 
bridge or ladder, press the left mouse button, move the object where you want 
it, then release the mouse button. Using the keyboard or joystick, press 
[ENTER] (or the fire button) to pick up the object, and again to place it. 

Use Open _to remove a boulder from your bug's path. Point to the offending 
boulder, then click the mouse or press [ENTER]. The boulder will vanish and 
reappear in another (random) position. 
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Use Trigger to change the size of your creature. Each Trigger spell will change 
to the next ize -- Small to Medium, Medium to Large, or Large to Small. Only 
Small bugs can travel through tunnels, only Medium bugs can climb ladders. 
Medium bugs like to eat Small ones, and are them elves the favorite food of 
Large bugs. All types are easily distracted when food , a predator, or a friend is 
near. Same-size bugs are attracted to one another. 

The Flame Dart spell will place a miniature sun in the maze. Use the mouse or 
cursor keys to position it. The bugs like warmth, and will be attracted to nearby 
heat sources. 

Should either bug die, a new one will appear at the top of the maze. 

Playing the "Dag-Nab-It" Game 

In the Thieves ' Guild , you can play the dagger throwing game, 
"Dag-Nab-It." The rules are simple: 
"You take turns with the Chief Thief throwing daggers at the board. Each 
hero gets three tum , and throws three daggers in each tum. As with a dart 
board, the closer to the center of the board, the higher the score will be. 
Highest score wins the bet. 
Adjust the force and angle of the throw with the arrow keys or mouse, 
according to your hand position. Pre Enter or click on the small 
Dag-Nab-It board to throw." 
The game is easy once you start playing it. 
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Quest for Glory I Walk-Through 

WARNING! The following section includes hints that experienced game 
players may not want to see. Continue reading ONLY if you have trouble 
getting started playing Quest for Glory. 

As you start Quest for Glory 1, you see a ' Hero Wanted ' poster and three 
signs. The first sign is ' highlighted ' with a blue rectangle. 

Press [ENTER] to see the stirring introduction and credits; then strap on your 
armor, take up your sword and shield, and prepare for the ultimate quest 
--Quest for Glory. 

On the 'Choose a Character' screen, click your mouse over the FIGHTER 
f>icture, or press your [TAB] key to highlight the FIGHTER, then press 
[ENTER] to select the FIGHTER. 

You will now see the 'Character Sheet' describing your character's abilities. 

Press [TAB] to highlight STRENGTH 25. 

Press right cursor [Arrow] key I 0 times. Your strength is now 75 . 

Press [ENTER] to start your Quest. 

A message window will appear after you enter each command. When you have 
read the message, press [ENTER] to remove the window and resume play. 

Type: look at sheriff 

Type: look at otto 

Type: ask about heroes 

Type: ask about brigands 

Use the mouse or [Arrow] keys to move your hero to the top right screen comer. 

Type: look at fruit 

(Short cut: Press [CTRL-L], and the computer will type look at for you. Then 
type: fruit and press [ENTER] .) 

Use the cursor keys to move your hero off screen-left. 

(If your hero is moving too slowly, press the [ +] key several times. [On slower 
computers, Press Escape to see the 'menus ' and choose HIGH SPEED HERO 
from the Game menu. NORMAL HERO SPEED will make it easier to walk 
around in tight areas.) 
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Type: look 

Use the cursor keys to move your hero to the door of the tavern (the door with 
the beer stein) and walk towards the door. The door will open for you 
automatically. 

You are now in the tavern. Read the messages. 

Type: save game, and then type: in the tavern. 

Use the cursor keys to move your hero to the center barstool. 

Type: sit 

Type: ask about drinks 

Type: order dragon's breath 

Type: drink breath 

(Oops! It was a good thing you saved the game! ) 

Type: restore game 

This brings us back to the point at which you saved the game. Everything you 
did after saving your game is now gone. Let 's try this again: 

Use the cursor keys to move your hero to the right bar stool. 
Type: look at stool 

Maybe Spiel burg really does need someone to clean up around here! 

Now that you 've been introduced to Spiel burg and the world of Quest for 
Glory, press [F9] to start the game over. Now select START NEW HERO, 
and create the Hero of your choice. Be sure to SAVE GAME frequently, and 
have fun! 
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NEED A HINT? 
~f you find yourself 'a little stuck' while playing a Sierra game, try the following 
ideas: 

1. If you have a modem, you can talk to the Sierra Bulletin Board 
through the following number: 

(209) 683-4463 

Our settings are 300, 1200 or 2400 Baud; 8 Data; N Parity; I 
Stop Bit. Our sysop will be happy to help you. 
2. Many other bulletin boards also provide hints to many of our 
games. 
A. Compuserve: Go into the Gamers Forum (GO GAMERS) 
or write E-Mail to 76004,2 143. 
B. Prodigy: Write E-Mail to 'HTWS90E', or go to the PC 
Club and enter the adventure games forum (Jumpword: PC 
CLUB). 
C. PCLink: Select PCLink Plus, enter Publisher's Connection, 
select Publishers Forums, then Sierra On-Line. E-mail may be 
written to the User ID 'SierraOnLi'. 
D. AppleLink: Select the KEYWORD option from the 'Goto' 
menu, and type: Sierra. E-Mail may also be written to the 
User ID 'Sierras'. 
E. GEnie: From the main menu elect 10 (Games), then select 
I (Games Round Table). Select 1 (Games Bulletin Board), 
and type set 22 at the'?' prompt. This will take you into the 
Sierra On-Line area. 
For more information on these BBS lines, you can call these 
toll-free numbers: 

1. Compuserve (800) 848-8199 

2. Prodigy (800) 822-6922 

3. PCLink (800) 458-8532 

4. AppleLink (800) 227-6364 

5. GEnie (800) 638-9636 

3. The magazine Questbuster's Journal is a helpful source of 
many game hints. 
4. Your local software dealer may carry our hint books, or may 
be willing to order them for you. 
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5. If you are unable to obtain a hint book through a dealer, you 
can order one directly from us. Call (800) 326-6654 to place your 
order with a Visa, MasterCard or American Express card, or 
write Sierra On-Line Inc., Order Department, P.O. Box 485, 
Coarsegold, CA 93614. 
6. If the hint book is not yet available for the game you are 
playing, call our automated hint line at (900) 370-KLUE to 
receive a hint. NOTE: California residents, please dial (900) 
370-5113. 
THIS SERVICE IS AVAILABLE 24 HOURS ADAY. THE 
CHARGES ARE: 75 CENTS FOR THE FIRST MINUTE 
AND 50 CENTS FOR EACH ADDITIONAL MINUTE. IF 
YOU ARE UNDER 18 YEARS OF AGE, YOU MUST 
HA VE A PARENT'S PERMISSION TO CALL. THE CON­
TENTS OF ALL MESSAGES ARE SOLELY THE 
RESPONSIBILITY OF SIERRA ON-LINE. HINTS WILL 
NOT BE GIVEN ON OTHER SIERRA TELEPHONE 
LINES. 

7. You may also request a hint by writing to us: 
Hint Department, 
Sierra On-Line, Box 485, Coarsegold, CA 93614. 
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PROBLEM DISK? 

TECHNICAL HELP (MS DOS ONLY) 

If you are having problems with a game disk, try these suggestions before 
assuming the disk is faulty: 

1. If you receive any of the following messages: 
1. 'Insert Disk#_' when you have already inserted that diskette, 
or have installed the game on your hard disk 
2. 'Out. of Handles' or 'Out of Heap' , or if the game locks up at 
any pomt 
3. 'Disk Error' 

you may have memory resident programs loaded into your RAM memory. You 
will need to boot your system from a diskette containing your operating system 
only. Follow these instructions to create a 'Sierra Boot Disk'. 

Format a blank disk with DOS system files (using /s) to make a bootable disk. 

FORMATTING FROM A HARD DRIVE 

A) Place a blank disk in drive a: 
B) At the C prompt, type: format a:/s 

NOTE: If your A: drive is a high density drive and you are using double density 
disks, you will need to type: format a:/4/s (for 5.25" disks) 

or type: format a:/n:9/s (for 3.5" disks) 

FORMATTING FROM A DISKETTE DRIVE 

A) Place your original DOS disk in drive A. 
B) At the A prompt, type: format a:/s 
NOTE: If your A: drive is a high density drive and you are using 
double density disks, you will need to type: format a:/4/s (for 
5.25" disks) 
or type: format a:/n:9/s (for 3.5" disks) 
C) Be sure to switch to a blank disk when prompted by the 
FORMAT program. 
D) Respond to DOS prompts. 

Now you should create a CONFIG.SYS file on your Sierra Boot Disk, with a 
files=20 statement. Follow these instructions to create this file: 

A) Type: a:[ENTER] 
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B) Type: copy con config.sys[ENTER] 
C) Type: files=20[ENTER] 
D) Press [F6][ENTER] 

You should see t~e message: '1 File(s) copied'. You will now have to re-boot 
your computer with your new Sierra Boot Disk in the drive. Turn your computer 
off then on, or press [Ctrl-Alt-Del]. 

If this does not. clear the above messages, call (209) 683-8989 for technical 
help. Our technical staff will be happy to help you. 

TECHNICAL HELP (ALL SYSTEMS) 

Techni~al assistance is only a telephone call away. Call (209) 683-8989 for 
convenient, person-to-person service, or if you prefer, you may request assis­
tance by mail. If you choose to write to us with your request, please state your 
computer type and the nature of your problem. 

If you find that you need to send for replacement diskettes send the original 
disk #1 in the size you need (3.5" or 5.25") to: ' 

Sierra On-Line 
P.O. Box485 

Coarsegold, CA 93614 
Attention: RETURNS 

Be sure to include a note stating your computer type, and the size of diskette 
you need (5.25" or 3.5"). 

We will .gladly replace your program free of charge for the first 90 days of 
ownership (please e~close a copy of your dated sales receipt with your request). 
After 90 days there 1s a $5.00 charge for 5.25" diskettes and a $10 00 charge 
for 3.5" diskettes. ' · 
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